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Para poder trabajar con el Sistema RVfpga asi como modificarlo, el usuario necesitara
construir un proyecto que incluya todos los archivos Verilog, SystemVerilog, de cabecera,
de configuracién y de texto que definen el sistema. En esta practica se mostrard como crear
un proyecto de Vivado que cargue RVfpgaNexys en la placa FPGA Nexys A7 de Digilent,
version -100T. (Recuerde que si tiene una placa Nexys4 DDR, también puede usarla.)
Siguiendo estos mismos pasos, podra modificar el Sistema RVfpga y resintetizarlo.

1. INTRODUCCION

IMPORTANTE: Antes de comenzar con las practicas de RVfpga, el usuario debe de haber
completado la Guia de Inicio RVfpga proporcionada por el Programa Universitario de
Imagination (https://university.imgtec.com/).

Asi, si no lo ha hecho previamente, debe instalar los programas Vivado de Xilinx, PlatformlO
y Verilator conforme a las instrucciones que se detallan en esa guia. Ademas, asegurese de
haber copiado en su maquina la carpeta RVfpga que ha descargado del Programa
Universitario de Imagination. Se hara referencia a la ruta absoluta del directorio donde copie
la carpeta RVfpga como [RVfpgaPath]. La carpeta [RVfpgaPath]/RVfpga/src contiene las
fuentes Verilog y SystemVerilog para el Sistema RVfpga, el SoC RISC-V que se utilizara y
modificara a lo largo de estas practicas. La carpeta [RVfpgaPath]/RVfpga/Labs contiene los
recursos que se usaran durante las practicas 1 a 10.

2. Creaci6on de un Proyecto Vivado para RVfpga

Se utilizara la Suite de Disefio Vivado de Xilinx! para construir RVfpgaNexys usando el RTL,
los archivos Verilog que definen el sistema. Siga los pasos que se detallan a continuacién
para construir RVfpgaNexys y cargarlo en una placa FPGA Nexys A7.

Paso 1. Abrir Vivado

Paso 2. Crear un nuevo proyecto RTL

Paso 3. Afiadir los archivos fuente RTL y los archivos de restricciones

Paso 4. Seleccionar Nexys A7 como placa objetivo

Paso 5. Configuracién del proyecto: Establecer rvfpganexys como Top Module,
common_defines.vh como Global include, afiadir el fichero boot_main.mem
al proyecto e incluir los directorios de Pulp Platform.

Paso 6. Generar el Bitstream

Paso 1. Abrir Vivado

Si no ha instalado Vivado en su maquina tal y como se describe en la Guia de inicio de
RVfpga, por favor hdgalo ahora. Asegurese de instalar también los archivos
correspondientes a la placa.

Ahora, ejecute Vivado (en GNU/Linux, abra un terminal y escriba: vivado; en Windows,
abra Vivado desde el menu Inicio). Se abrird la pantalla de bienvenida de Vivado. Haga clic
en Crear Proyecto (Create Project) (ver Figura 1).

1 En este material se utiliza Vivado 2019.2. Aunque la mayoria de las cosas también deberian
funcionar en las distribuciones mas recientes de Vivado, se recomienda el uso de esta version.
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¢ Vivado 2019.2 — O X

File Flow Tools Window Help Q- Quick Access

VIVADO! £ XILINX.

HLx Editions

Recent Projects

Quick Start

Create Project >
Open Project >
Open Example Project >

Tasks

AMmmm~a DY N v

< >

Tcl Console

Figura 1. Pantalla de bienvenida de Vivado: Crear proyecto

Paso 2. Crear un nuevo proyecto RTL
A continuacion se abrird el Asistente para Crear un Nuevo Proyecto Vivado (ver Figura 2).
Haga clic en Siguiente (Next).

¢ New Project X

Create a New Vivado Project

4
VlVADO This wizard will guide you through the creation of a new project.

HLx Editions
To create a Vivado project you will need to provide a name and a location for your project files. Next, you
will specify the type of flow you'll be working with. Finally, you will specify your project sources and

v choose a default part.
& XILINX.

Figura 2. Asistente para Crear un Nuevo Proyecto Vivado

Ponga como nombre del Proyecto (Project name) Proyectol y guardelo (Project location) en
la carpeta [RVfpgaPath]/RVfpga/Labs/Labl. Marque la opcion Create project subdirectory.
Después haga clic en Siguiente (Next) (ver Figura 3).
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Project Name
Enter a name for your project and specify a directory where the project data files will be stored. '

Project name: project_1
Project location: /home/dchaver/\VM_SharedFolder/RVfpga_l1-1/RVfpga/Labs/Labl D

Create project subdirectory

Project will be created at: fhome/dchaver/\VM_SharedFolder/RVfpga_1-1/RVfpga/Labs/Labl/project_1

el |

Figura 3. Nombre del proyecto

Seleccione el tipo de proyecto como Proyecto RTL (RTL Project), y haga clic en Siguiente
(Next) (ver Figura 4).

P

Project Type
Specify the type of project to create. '

RTL Project
You will be able to add sources, create block designs in IP Integrator, generate IP, run RTL analysis, synthesis, implementation,
design planning and analysis.

() Do not specify sources at this time

() Post-synthesis Project

\z) < Back Next > Cancel

Figura 4. Proyecto RTL

Paso 3. Afnadir los archivos fuente RTL y los archivos de restricciones
En la ventana Agregar fuentes (Add Sources), haga clic en Agregar directorios (Add
Directories) y seleccione [RVfpgaPath]/RVfpga/src (ver Figura 5). Asegurese que las dos
opciones siguientes estén seleccionadas (como se muestra en la Figura 5):
e Escanear y afadir archivos de inclusién RTL en el proyecto (Scan and add RTL
include files into project)
e Afadir fuentes de subdirectorios (Add sources from subdirectories)

Luego haga clic en Siguiente (Next).
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¢ New Project X

Add Sources

Specify HDL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new source file on '
disk and add it to your project. You can also add and create sources later.

+‘
In..  Na.. Library HDL Source For Location
. 1 src xil_defaultlib ~ Synthesis & Simulation -~ C/RVfpga
Add Files I] Add Directories Create File

Scan and add RTL include files into project
Copy sources into project

v/| Add sources from subdirectories

Target language: | Verilog v | Simulator language: | Mixed v

/:,\

Figura 5. Afiadir fuentes

Ahora se afiadiran las restricciones para el sistema. Estos archivos asignan los nombres de
las sefiales a los pines de la placa. Por ejemplo, los LEDs de la placa FPGA Nexys A7 estan
conectados a los pines de la FPGA en la placa a través de vias en la PCB. Vivado debe
conocer esto para poder mapear el nombre correcto de la sefial en el RTL al pin correcto de
la FPGA. Por ejemplo, la siguiente linea en el archivo
[RVfpgaPath]/RVfpga/src/rvfpganexys.xdc, un archivo de restricciones de disefio de Xilinx,
indica que el pin H17 de la FPGA se mapea al LED menos significativo (o_1ed[0]) y que
utiliza la sefializaciéon LVCMOS 3.3V:

set property -dict { PACKAGE PIN H17 IOSTANDARD LVCMOS33} get ports { o_led[0] }]

Tenga en cuenta que el nombre de la sefial o 1ed es el nombre utilizado en el codigo
Verilog del Sistema RVfpga para controlar los LEDs de la placa Nexys A7.

En la ventana Agregar restricciones (Add Constraints), haga clic en Agregar archivos (Add

Files) y seleccione los dos siguientes archivos (ver Figura 6):
[RVfpgaPath]/RVfpga/src/rvfpganexys.xdc
[RVfpgaPath]/RVfpga/src/LiteDRAM/liteDRAM.xdc

Luego haga clic en Siguiente (Next).
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New Project %

Add Constraints (optional)

Specify or create constraint files for physical and timing constraints. '

-

Constraint File Location
nfpganexys.xdc  /home/dchaverAM_SharedFolder/Rvfpga_l1-1/Rvfpga/src
liteDRAM.xdc /home/dchaverAM_SharedFolder/Rvfpga_1-1/RVfpga/src/LiteDRAM

Add Files | l Create File

[ ) Copy constraints files into project

® ==

Figura 6. Agregar restricciones

Paso 4. Selecciona Nexys A7 como placa objetivo

En la ventana Componente por defecto (Default Part), haga clic en Placas (Boards) y
seleccione Nexys A7-100T (Figura 7). Puede utilizar el cuadro de busqueda para filtrar los
resultados. También puede comprobar que el nombre de la FPGA objetivo real aparece en
la columna Componente (Part): xc7al00tcsg324-1. Esto indica que es una FPGA Xilinx
Artix-7 con 100k puertas equivalentes, con un paquete CSG (chip scale grid) y 324 pines.

Haga clic en Siguiente (Next).

Programa Universitario de Imagination — Practica 1 de RVfpga: Creacion de un proyecto de Vivado
Version 1.1 - 6 de julio de 2021

© Copyright Imagination Technologies 6



imagination

university programme

¢ New Project X
Default Part
Choose a default Xilinx part or board for your project. '
Reset All Filters Update Board Repositories
Vendor: | All v Name: | All v Board Rev: | Latest v
I Search: | . nexys I v | (5 matches)
Display Name Preview Vendor File Version  Part 1/C
A
Nexys A7-100T digilentinccom 1.0 xc7a100tcsg324-1 32
Nexys A7-50T digilentinccom 1.0 xcTa50ticsg324-1L 32
Nexys4 digilentinccom 1.1 xc7a100tcsg324-1 32
Nexys4 DDR digilentinc.com 1.1 xc7a100tcsg324-1 32
v
< >
[ o> |
\?) < Back Next > Cancel

Figura 7. Seleccion de la placa objetivo: Nexys A7-100T

En la ventana de resumen de un nuevo proyecto (New Project Summary), haga clic en
Finalizar (Finish), véase la Figura 8.

# New Project

New Project Summary

VIVADO’

HLx Editions © AnewRTL project named 'Project1’ will be created.

© 198 source files will be added.
@2 constraints files will be added.

© The default part and product family for the new project:
Default Board: Nexys A7-100T
Default Part: xc7a100tcsg324-1
Product: Artix-7
Family: Artix-7
Package: csg324
Speed Grade: -1

i: Xl LI NX To create the project, click Finish
?

Figura 8. Ventana de resumen del nuevo proyecto

Tenga en cuenta que una vez que el proyecto termine de configurarse, indicard que existen

archivos con errores de sintaxis - esto se solucionara en el siguiente paso.
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Paso 5. Configuracion del proyecto: Establecer rvfpganexys como Top Module,
common_defines.vh como Global include, afadir el fichero boot_main.mem al
proyecto e incluir los directorios de Pulp Platform.

Establecer rvfpganexys como Top Module: Establezca el médulo rvfpganexys como el
Top Module (médulo superior). En el panel Fuentes (Sources), desplacese hacia abajo en
Fuentes de Disefio (Design Sources), haga clic con el botén derecho del ratén en el médulo
rvfpganexys y seleccione Establecer como Superior (Set as Top) (véase la Figura 9).
También puede encontrar el médulo rvfpganexys escribiendo este nombre en el cuadro de
busqueda, como se muestra en la citada figura. Esto establece rvfpganexys como el
modulo de mas alto nivel en la jerarquia y el objetivo a ser sintetizado e implementado en la
FPGA. Después de establecer rvfpganexys como el mddulo superior, la jerarquia se
actualizara.

File  Edit Flow Tools Reports Window Layout View Help

= B X > B & X )’ 4

4

4
Flow Navigator E B PROJECT MANAGER - project_1

v PROJECT MANAGER

Sources D =ik BaX Project Su
£+ Settings
= = : Overview
Add Sources Q + 0 o
Language Templates Search: Q- nfpganexys (3 matches) Settings
T IP Catalog v . Design Sources (135 A " e
v @ ppganexys (nfpganexys.sv) (7) polgctie
n t lo¢
v IP INTEGRATOR ® clk_gen: clk_gen r Source Node Properties... =
> @ mem : AXI_BUS (axj i
Create Block Design > @ cpu: AXI_BUS Open File t pe
pen Block Desiqr > @ cdc: axi_cdc_intf Replace File... .OIdU
v @ ddr2: litedram_top : : raan
“@ I REwtui Copy File Into Project \tor
v @ serv_rf_top | Copy All Files Into Project
v SIMULATION - : :
< X Remove File from Project... Pa
Run Simulation z BC SR
Hierarchy Libraries Co
yne
Disable File
v RTL ANALYSIS Source File Properties par‘
> Open Elaborated Desian Move to Simulation Sources revi
P 9 ® nfpganexys.sv
ctol
v SYNTHESIS iton
V) Enabled Hierarchy Update 4
P Run Synthesis . {
) ik Location: fhome/dcha: C  Refresh Hierarchy e
4 Type: SystemVeril¢ IP Hierarchy »
Library: xil_defaultlib 5 :
v IMPLEMENTATION L4 = sapSetesTop esit
» Run Implementation Ske: B:2'B L.
5 Modified: Today at 15 ges
<
v PROGRAM AND DEBUG General Properties Strategy:
¥5 Generate Bitstream
Tcl Console | Messages | Log | Reports | Design Runs

> Open Hardware Manager

Figura 9. Establecer rvfpganexys como médulo superior

Establecer common_defines.vh como Global include: Ahora, aun en el panel de Fuentes
(Sources) bajo Fuentes de Disefio (Design Sources), expanda el grupo de archivos No-
maédulos (non-module files) y haga clic en common_defines.vh. Las propiedades del archivo
se abriran en el panel Propiedades del archivo de origen (Source File Properties), justo
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debajo del panel Fuentes. Haga clic en Inclusién Global (Global Include) para marcar esa
casilla (véase la Figura 10). La jerarquia se actualizara e incluira ese archivo en Fuentes de
Disefo/Inclusion Global (Design Sources/Global Include). Tenga en cuenta que los Archivos
de error de sintaxis desapareceran en el siguiente paso.

¥ PROJECT MANAGER
£ Settings
Add Sources
Language Templates

1F 1P Catalog

~ IP INTEGRATOR
Create Block Design
Open Block

Generate Block Design

v SIMULATION

Run Simulation

~  RTL ANALYSIS

> Open Elaborated Design

v SYNTHESIS

P Run Synthesis

> Open Synt

~ IMPLEMENTATION
P Run Implementation

> Ope

mplemented Desig

v~ PROGRAM AND DEBUG

Reports

X,

File  Edit Flow Tools
B « - 6
Flow Navigator F

¢ Projectl - [C:/RVfpgalabs/Programs/Lab1/Project1/Project1.xpr] - Vivado 2019.2

esized Design

- ] b4
Window  Layout  View  Help O Quick Access Ready
B oa oz 4 Default Layout v
PROJECT MANAGER - Project1 ? X
Sources ? 0o X Project Summary 200X
Ql = | =2+ 2 o Overview | Dashboard
~
Search: © Settings  Edit
Design Sources (125) o . .
Project name: Project1
Global Include (1 Project location: C:/Rvfpga
Verilog Header (15) Product family: Artix-7
Non-module Files (6 Project part: Nexys A7-
® wh_common.y Top module name: vfpga
® bootloadervh Target language: Verilog
© common defines.vh Simulator language: Mixed
- - = v
Hierarchy = Libraries Compile Order
Board Part
Source File Properties ?2 00 X Display name: Nexys A7-101
Board part name: digilentinc.cc
© common_defines.vh - o .
Board revision: D.0
neau-ury. o 7
Connectors: No connectic
Encrypted: No . - ‘
Repository path: C:/Xilinx/Vive
Core Container: _No URL: https://refere
| Global include Board overview: Nexys A7-10i
Used In v
> Synthesis
e
General  Properties 3 >
Tcl Console |Messages Log | Reports | Design Runs X ? 00
a = = + %
Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power Failed Routes LUT FF
synth_1 constrs_1 Not started :
< >

Figura 10. Establecer common_defines.vh como archivo de inclusién global

Afadir el fichero boot_main.mem al proyecto: En la ventana Flow Navigator, haga clic en
Add Sources, mantenga la opcion por defecto (“Add or create design sources”), y haga clic

en Add Files (ver Figure 11). Navegue a la carpeta
[RVfpgaPath]/RVfpga/src/SweRVolfSoC/BootROM/sw y seleccione el fichero
boot_main.mem (como se muestra en la Figure 11). La jerarquia de mddulos se actualizara
y se incluird el nuevo fichero en Design Sources/Memory File.
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Flow Navigator )

Edit Flow Tools Reports
~ PROJECT MANAGER
£+ Settings

Add Sources

Language Templates

F IP Catalog

v IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

v SIMULATION

Run Simulation

v RTLANALYSIS
> Open Elaborated Design

v SYNTHESIS
P Run Synthesis

> Open Synthesized Design

v IMPLEMENTATION
P Run Implementation

> Open Implemented Design

v PROGRAM AND DEBUG
¥ Generate Bitstream

> Open Hardware Manager

.
> W

Window  Layout Help

& Z

PROJECT MANAGER - project 1

View
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Q- Quick Access

Sources

Q

Search: |

@ serial_deglitch (se.

@ stream_join (st

@ stream_mux (s

@ unread (un

@ wb_data_resize (wb_data
> [ Constraints (2)

Add or Create Design Sources

. Specify HOL netlist, Block Design, and IP files, or directories containing those file types to add to your project. Create a
new source file on disk and add it to your project.

Project Summary

Overview | Dpashboard

Settings  Edit

/

> [ Simulation Sources (130) +‘
> = Utility Sources Add Source
Hierarchy Libraries omp
Look in: sw
Source File Properties boot man.elf
® boot_main.vh Use Add Files, Add Dire¢ [ 1} paat_main.mem
@ boot_mainvh
¥ Enabled
Location: {home/dchavel
Type: veriog | [+
Library: «il_defaultlib | Add Files Ad
Size: 0.4 KB
Modified: ‘Yesterday at 1
<
General  Properties
@
Tcl Console | Messages  x h
> 2 vy 3@ (@)@ Critical warning (721) ()% Warning (440)
T s T (7] & a a 9

> %a Vivado Commands (2 critical warnings)

Filo pame:  boot_main.mem

HIJZViérUkr'é‘ii'.ﬁAﬁ'adir el fichero boot_main.mem

Este archivo (boot_main.mem) se utiliza para inicializar la Boot ROM del SoC. Para ello, se
invoca como parametro en el archivo [RVfpgaPath]/RVfpga/src/rvfpganexys.rv:

main.mem")

bootrom file

La Seccion 6.A de la Guia de Inicio contiene mas informacion sobre este fichero.

Incluir los directorios de Pulp Platform: Para terminar, incluya los dos directorios de la
Pulp Platform (ver Figure 12). En la ventana Flow Navigator haga clic en Settings, y en la

ventana que se abre haga clic en General y luego en Verilog options (

). En la nueva

ventana, afiada los dos siguientes directorios haciendo clic en + y navegando a los

siguientes directorios:

[RVfpgaPath] /RVfpga/src/SweRVolfSoC/Interconnect/AxiInterconnect/pulp-platform.org axi 0.25.0/include
[RVfpgaPath] /RVfpga/src/OtherSources/pulp-platform.org common cells 1.20.0/include
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File  Edit Flow Tools
h‘
Flow Navigator =

~ PROJECT MANAGER
Add Sources
Language Templates

¥ IP Catalog

v IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

v SIMULATION

Run Simulation

v RTL ANALYSIS
> Open Elaborated Design

v SYNTHESIS
P Run Synthesis

> Open Synthesized Design

v IMPLEMENTATION
Run Implementation

> OpenImplemented Design

v PROGRAM AND DEBUG
Generate Bitstream

> Open Hardware Manager

Window

Layout  View Help

Project Settings
Simulatian

Elaboration
Synthesis
Implementation
Bitstream

> P

Tool Settings
Project
IP Defaults
Board Repositary
Example Project Repositary
Source File
Display
WebTalk
Help
» Text Editor
3rd Party Simulators
» Colors

©)

Used In
[ synthesis

[¥] Implementation

General Properties

Q- Qu

Td Console

a = 2

Messages Log

ick Access

General
Specify values for various settings used throughout the design flow, '
These settings apply to the current project.

Name: project_L

Project device: B Nexys A7-100T (xc7a100tcsg324-1)
aredFolder/R\Vfpga_1-1/RVfpga/labs/Labl
Target language: Verilog ~

Default library: ¥il_defaultlib DOtcsg324-1)

nfpga E

iclude } verilog_version=Verilog 2001

Generics/Parameters: D

Top module name:
Language Options

Verilog options:

Verilog Options o

Specify compilation options for Verilog files.

Verilog Include Files Search Paths

thome/dchaveriM_SharedFolder/Rvfpga_1-1/Rvfpgarlsrc/OtherSources/pulp-platform.org__common_cells_1.20.0finclude
fhome/dchaver/VM_sharedFolder/Rvfpga_l-1/Rvfpga/src/SweRVolfSoC/interconnact/Axilnterconnect/pulp-platform.org__axi_0.25.0/include

Defines

Figure 12. Incluir directories para la Pulp Platform

Paso 6. Generar el Bitstream
Haga clic en Flujo (Flow)— Generar Bitstream (Generate Bitstream), como se muestra en la
Figura 13. Puede aparecer una ventana que comunique que no hay resultados de
implementacién disponibles y solicite permiso para lanzar la sintesis y la implementacién
(ver Figura 14). Haga clic en Si (Yes). A continuacion, haga clic en OK en la ventana de

Lanzamiento de ejecuciones (Launch Runs) (ver

Figura 15). Este paso sintetiza

RVfpgaNexys (conforme a lo definido en los archivos Verilog y SystemVerilog del proyecto),
lo mapea en la FPGA y crea el Bitstream. Este proceso tipicamente toma 20-50 minutos,
dependiendo de la velocidad de su computadora.
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ﬁ Settings
] Add Sou
Languag

1F IP Catalo

v~ P INTEGRAT

Create Bl
Open Bl¢

Generate

v SIMULATION

Run Simi

Flow

01
10

Tools  Reports  Window

Project Manager

Settings

Create Block Design

Run Simulation

Open Static Simulation...

Open Elaborated Design

New Elaborated Design...

Run Synthesis
Open Synthesized Design
New Synthesized Design...

Run Implementation

Open Implemented Design

Hardware Manager
Generate Bitstream

Create Runs...

Figura 13. Generacion del Bitstream
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No Implementation Results Available

D Don't show this dialog again

There are no implementation results available. OK to launch synthesis and
implementation? 'Generate Bitstream' will automatically start when synthesis
and implementation completes.

Yes

Figura 14. Ventana de lanzamiento de la sintesis y la implementacion
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¢ Launch Runs X

Launch the selected synthesis or implementation runs.

Launch directory: s <Default Launch Directory> v
Options
®) Launch runs on local host:  Number of jobs: 8 v

Generate scripts only

, Don't show this dialog again

Figura 15. Lanzamiento de ejecuciones

Después de que se haya generado el Bitstream, aparecera una ventana como la que se

muestra en la Figura 16. Haga clic en el boton % de la esquina superior derecha para
cerrar la ventana.

Bitstream Generation Completed X

o Bitstream Generation successfully completed.

Next
Open Implemented Design
View Reports
® Open Hardware Manager
Generate Memory Configuration File

Don't show this dialog again

Figura 16. Generacion del Bitstream finalizada

Ahora que ha construido el sistema RVfpgaNexys por usted mismo, podra reconstruirlo
después de modificarlo en las préacticas 6-10. Por ahora comenzard a usar el sistema
RVfpgaNexys que acaba de crear, para descargar y ejecutar programas en €l usando
PlatformlO.

Se recomienda usar PlatformlO para descargar RVfpgaNexys en la placa Nexys A7. Este
método se describidé en detalle en la seccion 6.A de la Guia de inicio de RVfpga (GSG).
Como también se describe en la GSG para los diferentes ejemplos (6.B a 6.H), después de
descargar RVfpgaNexys en la FPGA de la placa Nexys A7, se utilizara PlatformlO para
descargar y ejecutar/depurar programas en RVfpgaNexys.

También puede usar Verilator, un simulador HDL, para simular la ejecuciéon de programas
sobre RVfpgaSim, tal y como se describe en la seccion 7 de la Guia de inicio de RVfpga.
Estas simulaciones a nivel RTL permiten visualizar sefiales de hardware de bajo nivel segln
se ejecuta el programa de software. Se utilizara Verilator en gran medida en las practicas 6-
10, conforme se vaya extiendiendo el Sistema RVfpga y se prueben y depuren los cambios
realizados.
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